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1 SIGNALIZATION PLANS 

OBJECTIVE 

This chapter is divided into three sections: 

 Computer Aided Drafting and Design (CADD) Standards & File Creation 

This section contains: 

o General discussion on Signalization Plans and File Creation. 

o Launching the FDOT C3D shortcut on the desktop. 

o Using the FDOT Create File application to create the base files for a project. 

 Traffic Plans Menu 

This section discusses setting up the FDOT Traffic palette to add entities to the Traffic Plans. 

 Layers, Text and Models 

This Section discusses features/concepts used in Civil 3D 2017. 

o Layers 

o Layer Filters 

o Text Styles 

o Annotation Scale 

o Sheet Layout Tabs 

INTRODUCTION 

This chapter reviews the FDOT C3D working environment including how to properly create design files that 
meet the Department’s CADD standards.  

GENERAL CADD STANDARDS & FILE CREATION 

GENERAL DISCUSSION ON TRAFFIC PLANS AND FILE CREATION 

Traffic Plan projects are normally a component of a Roadway plans package. Therefore, the project directory 

structure usually exists prior to beginning work on a Traffic Plans component. If this is not the case, the same 

directory structure and file standards that apply to Roadway apply to any other lead component. The Department’s 

CADD Manual defines the naming convention used to create the different types of design files required in a 

project. 

LAUNCHING THE FDOT C3D ICON ON THE DESKTOP 

When the Department’s CADD software was installed a folder named FDOT20xxC3D was placed on the 

desktop. This folder contains shortcuts to applications used when working on the Department’s projects. The 
FDOT C3D Shortcut will also be placed on your desktop when the installation is complete. 

The figure below shows the FDOT Civil 3D 2017 Shortcut. 
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It is recommended to use This shortcut to start Civil 3D, because it will start the program with the proper Civil 
3D workspace with the FDOT Ribbon which can alleviate, among other things, issues with using the wrong 

CADD standards. 

The Department delivers a desktop shortcut for starting Civil 3D: 

o FDOT C3D 2017 – Uses the AutoCAD 2013 dwg file format and FDOT CADD standards. This 
option requires an existing installation of AutoCAD Civil 3D 2017. 

 

Upon launching the Civil 3D State Kit the FDOT Civil 3D Profile is loaded into the Civil 3D workspace but does 
not set the Data Shortcut folder unless previously set. If user is working on multiple projects the project number 

will need to be selected before work commences.  To set the Data Shortcut folder to the appropriate project do 

the following. You will need to complete this step to continue to exercise 1.1 

1. Select the Data Shortcuts option located on the toolspace then right click.  

2. Select Set Working Folder and browse to the root folder of your projects (Do not select the actual 
project number). 

 

3. Select and right click on Data Shortcuts again and select Select Data Shortcuts Project Folder. 

4. Select the appropriate project number from the list and select ok. 

 

Now all design files created using the Create File application will use this project number to populate the 

appropriate folders with drawing files. 

 

USING FDOT CREATE FILE - CREATE BASE FILES FOR A PROJECT 

The Create File application is used to create Civil 3D design files and other files in accordance with the 
Department’s CADD standard file naming conventions.  Create File reads the MasterStandards.xlsx file to get 

the current Layers, Linetypes, Colors, etc. so it can propagate the appropriate design file. The file is located in 

the state kit install folder. Create File can only be accessed from inside of Civil 3D on the FDOT Ribbon. The 
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advantage to using this tool to create files is that the design file will always be named according to the 
Department’s CADD standards and will pass QC.. 

The Figure below shows the Create File application. 

 

Exercise  1.1 Creating the Base Files for a Project 

 Creating Signalization files 

 With Civil 3D still open and the Data ShortCuts from the previous step set up. Click on Create File 

Located on the Ribbon.   

 Click on the Select Project button and browse to project 22049555201. 

Note If you have used the Create File application there is a previous history of selected projects. Click on the 
Project pull-down to view to re select a project 

 Set Discipline to Roadway. 

 Set File Group to Signal Design Files. This sets the proper Output Folder in your project. 

 Set File Type to Proposed Design and Signal Information. This sets the Output Filename and the 

correct template file. 

 The information on the bottom should already be filled in. If the Coordinate system is not already set 
to the appropriate system set it to FL North.  

Note The advantage of setting the data shortcuts in advance of using create file is that if the coordinate zone 
is already set in the project it is automatically selected when you create/open your file so your zone is 
already set in your new design file. 
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 Your Create File dialog should match below. 

 

 Select Create/Open to start the drawing creation process. When the new drawing is open select Close 
on the dialog box. 

Note This version of Create File allows the designer to browse to a different Output Folder or Template if 
needed.  

 

Note If the file Dsgnsg01 already exists in this project, the application will increment the file name to Dsgnsg02 
and will not overwrite the file. 

 Go on to the Optional Exercise or click OK to close the Create File/Project tool. 

 

Exercise  1.2 (Optional) Create Additional Files 

 Use same File Group to create additional design files 

 Using the Create File application select the Tabulation of Quantity Sheets file. 

 Select the Create/Open button. 

 Repeat steps 1 and 2 to create the Summary of Pay Item file. 

 Click Close on the Create File application. Close and save the newly created drawing file(s). 

  



SIGNALIZATION PLANS - General CADD Standards & File Creation __________________________________________ Chapter 1 

FDOT Traffic Plans Course - Signalization ©2017 FDOT 1-5 

Exercise  1.3 Getting familiar with the FDOT Civil 3D Workspace 

In this exercise, open Civil 3D with the FDOT Civil 3D Shortcut.      

 Click on the FDOT tab to switch to the FDOT Ribbon. The FDOT Civil 3D Ribbon contains all of the 

applications and tools needed to aid you in producing plans based on the departments standards. 

 

 

 Click on the home tab to return to the main Civil 3D Ribbon. 

 If your tool palettes are not turned on select the tool palette button.   The palettes will 

fill the right side of your screen. The FDOT Subassemblies is the default palette 

 Right click on the control bar where it says Tool Palettes and select FDOT Traffic. 

 

 The FDOT Traffic Palette Group will load. There are 5 tabs located vertically on the palette. 

 Mast Arms/Assemblies – Contains Dynamic Mast Arm Blocks that can be inserted 

into the Signal design file. 

 Signal Blocks – Contains Signal Blocks that can be inserted into the Signal Design 

File 
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 Signal Heads – Contains Signal Head detail blocks that can be inserted into the 
Signal Design File. These blocks are annotative so they can be inserted in paper space 

or model space. 

 Pedestrian Signal Heads – Contains Pedestrian Crossing Blocks that can be inserted 

into the Signal Design File. These blocks are annotative so they can be inserted in 

paper space or model space. 

 Signal & Lighting Tables – Contains AutoCAD Tables for Signal and Lighting 

design that can be inserted into design file and data entered. 

 

LAYERS, LAYER FILTERS, ENTITY MANAGER, & TEXT STYLES 

LAYERS 

The Department has created six Standard Layer libraries: Common, Survey, Right of Way, Roadway, 

Photogrammetry and Structures. There are approximately 1400 Layers. The appropriate Layer library is loaded 

when a Civil 3D file is created or opened using the FDOT Workspaces.  

The Layer name is divided into three components: Layer Name, State & View 

o The format of the Layer / Layer Name is: object_sv  (max. 18 characters)  

Where:  (object = entity type)_ (s = state)(v = view) 

(S)tate Designations (V)iew Designations 

p (proposed) 
p (plan)  

d (drafting entity) 
r (profile) 

e (existing) 
x (cross section) 

 
m (model) 

An example of a Plan View Layer is: PoleLight_ep.  

1. Layer Name – PoleLight 

2. State - e 

3. View - p 
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Note Some Layers do not show a State or View in their name. These Layers are set by default to be a 
proposed plan view entitiy. An example is the Layer (PullBox) this Layer is created for proposed Pull 
Boxes in the plan view. 

The Layers symbology of color, weight and style are set to ByLayer. What this means is that each Layer takes 

on the properties the user has set as far as color, weight and line style. It is recommended that Designers do not 

create additional Layers because that will cause the drawing file to fail QC. 

RULES & LAYER FILTERS 

The Department has also created a set of Standard Rules that group the Standard Layers together for the 

purpose of Quality Control (QC) checking of the Department’s Standard design files ensuring compliance 

with the Department’s CADD Standards.  The Department delivers Civil 3D Layer Filters to reflect each of 
these Standard Rules to assist in users searching through the Layer Properties Palette.  These filters are 

discussed later in this section. The Layer Filters do not turn Layers on or off, but they reduce the number of 

Layers visible in the drawing. 

Activating a Standard Layer Filter is very easy and can be done from the Layer Properties Palette located on 

the Home Ribbon. Expand the Standards in the filters section of Layer Properties and select the appropriate 

rule name. 

 

Note By default the Standard Layer Filter is automatically set to specific file name that was created using 
the Create File application. 

ENTITY MANAGER (EMX) 

Entity Manager is used to define the symbology of entities and allows user to place, draw, and edit entities with 

pay item data attached. The symbology of the entities placed such as the correct layer, proper block, etc is 

controlled by the EMX application. For a more detailed explanation of the functionality refer to the fdot Entity 

Manager Reference Guide located in the FDOT2017.C3D/APPS/EntityManager folder 

TEXT STYLES 

A text style is comprised of a group of text attributes, such as font, width, height, spacing and so on. The 

Department delivers predefined text styles, which should be used whenever possible. The text styles delivered 

by the Department are created at a scale of 1 to 1. This is important to remember when placing text using 

Annotation Scale. Annotation Scale is discussed in more detail later in this section. 
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TEXT STYLE DIALOG BOX 

The Text Style dialog can be accessed by typing ST and then enter on the command line. 

 

The Text Styles dialog box shows all of the text styles that exist in the design file, and all of the parameter 

settings for each style. When a new file is created and opened it is based on the fdotmaster.dwt which has all 

of the appropriate text styles loaded. No changes should be made to the delivered text styles. 

 

TRUE TYPE FONTS 

The Department has integrated the use of True Type Fonts and restructured the Text Styles.   

True Type Fonts will ignore weights.  The best method to show thicker text is to use the Bold font.  The True 

Type Fonts delivered by the Department will be installed by the installation and are located in the 

FDOT2017.C3D\SUPPORT\FONTS folder on the server and in the Windows\Fonts folder on the client.   

STYLE ORGANIZATION 

Fonts at Common Sizes  40 Scale  50 Scale 

Large = .125 x Scale 5.0  6.25 

Medium = .1 x Scale 4.0  5.0 

Small = .07 x Scale 2.8  3.5 

ANNOTATION SCALE 

Annotation Scale associates all of the text placed in a view to a specific scale so if the scale of that view is 

changed the text dynamically changes with it.  

Using Annotation Scale also removes the burden of having to calculate what text height should be used at a 

particular scale when placing text.  

The default scale is set to 1”=40’as shown in 
the image at right. 

 

 

 

 

 

Exercise  1.4 Setting up the Design File  
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 X-Reference Files, Data Shortcuts  

This exercise will cover attaching required reference files and data shortcuts to our design file. There is more 

than one way to start the Xref Manager dialog. Use the method most familiar. 

 Continuing with Dsgnsp01.dwg open the Xref Manager dialog box by typing XREF on the command 
line then enter.  

 

 In the External References dialog, select the attach pull down as shown above > Attach DWG. This 

opens the Attach External Reference dialog. 

 Navigate to the Roadway folder. 

 Attach the reference file Dsgnrd01.dwg in the roadway folder. 

 Click on Open. This opens the Reference Attachment Settings dialog box. 

 Change the Reference type to Overlay and unclick the Insertion Point toggle as we want this file to 

come in at the correct coordinate zone. The dialog should match below. Click OK.  

 

 Do a zoom extents to see the newly attached file. 
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Note It may be necessary to attach the Topord*.dwg, Utexrd*.dwg and Drexrd*.dwg files depending on the type of 
project being worked. If there are conflicts with any of the existing features than that reference file should be 
displayed. Refer to the Plans Preparation Manual Volume II - Chapter 23 for further guidance. 

 Data Shortcuts 

This exercise will cover Data Referencing in the Alignment data. Data Shortcuts are an easy way to bring in 
Civil 3D objects without having to reference an entire drawing file. 

 Continuing in Dsgnsp01.dwg On the Toolspace expand the Alignments tree in the Data Shortcuts 
section > Right Click on US98 and select Create Reference. 

 

 The Create Alignment Reference dialog box opens. The options should be already filled in since it 
reads the default settings and commands from the fdotmaster template. Your dialog should look like 

the image below.  

 

 Source Alignment –  The name of the Alignment is 

set from the name in the Data Shortcut list. 

 Site – Alignments should be Site less (None). Sites 

are object holders that allow entities or objects in the 

same site to interact with each other. 

 Name & Description – The name of the Alignment 
and a more informative description of the Alignment, 

which is recommended. 

 Alignment Style – The default is FDOT Proposed. 

If you click on the pull down arrow you can see all of 

the styles available. 

 Alignment Layer- The layer is set in the template 

using the object layers option in drawing setup. 

 Alignment Label Set – The default is the 40 scale 

annotative label set. If using a different scale use the 

pull down to select the matching scale for your label 

set. 

 Select OK to bring in the Alignment reference. Zoom > Extents to see the alignment. 

 Save the file before continuing. 
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 Layers and Filters  

This exercise will cover investigating Layers and Layer Filters delivered by the Department. The entities 

placed in this exercise are not part of the final design; they are for experimenting and practicing only. 

 Continuing with Dsgnsg01.dwg  select the Layer Properties on the Home Ribbon to open the Layer 
Properties Palette.  Under Filters expand the Standards tree and select the dsgnsp filter. 

 

Note As a refresher, a Layer filter isolates the Layers seen in the Layer dialog so it is easier to navigate. The Layer 
filters are grouped by the filename.  

 In the Layer Name list to the right double click on the Layer ConduitBM. This sets the current Layer 
to ConduitBM and sets the Color, Weight and Style because all Layers are set up ByLayer. The 

current layer always has a green check mark before the name. 

 

 with the Layer Properties Palette, still open collapse the Standards tree and select the Text filter. 

 Take a moment to review the Layers in this filter. Notice that all Layers visible are associated to text.  

 Now that the Filter is loaded, navigate the Layer drop down menu and select the Layer that is 

appropriate to the item being placed. It is important to understand how useful the Layer filters are, 

they will save time when going from Line work to Text. 

  Annotation Scale and Text Styles  

This is a brief introduction to placing text using the Department delivered Text Styles. This is discussed in 

more detail later in this course. 

 Continuing with Dsgnsg01.dwg double click on the TextLabel layer to make it current. Close the 
Layer Prop. Dialog. 

 Select the Annotate Ribbon. Take time to become familiar with the text options available.  

 For a sample we are going to place some Multiline Text. Notice the default style is the FDOT font 

which is already set to annotative which is represented by the blue triangle. 
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 Click on Multiline Text > then draw a rectangle in the drawing area for the text box.  

 To see how Annotative text behaves change the drawing scale from 1”=100’. 

 

 The text is bigger due to the scale being smaller. Notice how the Alignment labels also adjust. 
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2 CREATING A KEY SHEET 

OBJECTIVE 

The objective of this chapter is to teach the student how to create a Signalization Key Sheet that meets the 

Department’s CADD standards. 

INTRODUCTION 

Once the student has completed this chapter they will be able to create a Key Sheet and all of its components that 

follow the Department’s CADD standards. The Department’s CADD standards and the Plans Preparation manual 
will be adhered to for the creation of this sheet. 

GENERAL INFORMATION 

The key sheet is the first sheet in the set of construction plans. The information shown on the Signalization plans 

key sheet varies depending if the Signalization plans are a component of the Roadway plans or the lead 

component. For example, if the Signalization plans are a component of the Roadway plans, you do not need a 

location map or length of project box because this information is on the lead key sheet. This also applies to the 

Signing & Pavement Markings and Lighting plans key sheets. Refer to Chapter 3 Volume II of the Plans 

Preparation Manual for more information. 

During the creation of a Key Sheet, the designer is required to take the actions listed below.  

Produce the graphical portion of the sheet with these entities:  

 Use Create File to create the desired discipline Key Sheet. 

 Place the project location map (only on a lead Key Sheet). 

 Place the Section, Township and Range lines (only on a lead Key Sheet). 

 Begin Milepost (correct to three decimal places). 

 Place the North arrow block for a key sheet (only on a lead Key Sheet). 

 Identify all Railroad Crossings (only on a lead Key Sheet). 

 Fill in component Plans (Only on a lead Key Sheet). 

 Index of Sheets & Revision Table 

Fill in the project data, including the following (Text with Gray Background represents Fields which are 

entered through the sheet properties):  

 Financial Project ID, Number 

 Federal Funds (if applicable) 

 County Section Number, County Name and State Road Number  

 Fiscal Year 

Note: Some of the data will automatically be filled in to the fields on the keysheet after you use 
the Create Project application  
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PROJECT LOCATION MAP 

Florida county maps are available for download from the Department’s Surveying & Mapping web page. 
http://www.dot.state.fl.us/surveyingandmapping/countymap.shtm 

These maps are available in PDF file format. Download the PDF file into the appropriate project directory. This 
file is used by the Key Sheet Clipping tool to attach, scale and clip the map to the key sheet.  

The Project Location Map is placed in the center of the sheet and sized so as not to interfere with other entitys on 

the Key Sheet. Its purpose is to provide enough information so that the project location is easily understood. 

Township, Range, and County lines and numbers are shown to make the location clear. 

USING CREATE FILE TO CREATE A SIGNAL DESIGN KEY SHEET 

Create File application will create Key Sheets for all disciplines and place them in the appropriate folder. 
The advantage of using Civil 3D is there are Sheet Layouts along the bottom of the newly created Keysheet 

representing every Discipline and variation simply delete the Layouts not needed.  

When a Key Sheet is created notice all the layouts on the bottom of the file, there are options for (FF) Federal 

Funds or without with maps or without. To delete the unwanted layouts either right click on them individually 

and select delete or holding the ctrl key select the layouts and right click to delete a group. 

 

Note No matter what discipline of key sheet you will need it will always be this base file as a starting point. If 
you were creating a key sheet with a map you would delete all but the ones with a map designat ion in 
the layout name. If you needed a map with your signal key sheet you would simply copy and paste the 
viewport and other map text to the appropriate discipline sheet layout.  

INDEX OF PLANS 

The Index of Plans is used to describe what sheets and corresponding sheet numbers are in the set of plans. There 

is an Index of Plans table on each key sheet which the user will type in the sheet numbers and descriptions. There 

is a tool in Civil 3D called Sheet Set Manager (SSM) that you will use to assemble your set of plans. It is discussed 

later in the manual. To aid in the data entry of the Index of plans the user can select their sheet set > right click > 

Insert Sheet List Table and then copy and paste the data into the Index of Plans. 

  

COMPONENTS OF CONTRACT PLAN SET 

The Components of Contract Plan Set is a list of all disciplines that are a component to the lead project. The order 

of the component plans is: 

1. Roadway 

2. Signing and Pavement Marking 

3. Signalization 

http://www.dot.state.fl.us/surveyingandmapping/countymap.shtm
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4. Intelligent Transportation Systems (ITS) 

5. Lighting 

6. Landscape 

7. Architectural 

8. Structures 

Note If your project includes Signing and Pavement Markings, Signalization or other component sheets as part 
of the Roadway Plans and those sheets are numbered consecutively within the Roadway Plans then 
these are not to be shown as components of the contract plans set. 

The Component Set is populated by double clicking on the COMPONENTS OF CONTRACT PLANS SET in 

the key sheet to activate Mtext mode and fill in the information. As another alternative you could create a word 
document and link it to the key sheet. If the word document is updated the link updates the key sheet. 

 

This file is set up for the lead key sheet in the set of plans. If a Signalization Key Sheet without a map is created, 

this file will not be used because there are no components; hence, there is no COMPONENTS OF CONTRACT 
PLANS SET option on the key sheet. 

STRUNG PROJECTS NOTE 

Projects that are independently prepared, but are let in the same construction contract shall have the additional 

Financial Project IDs noted on the right side of the key sheet below the Plans Prepared By block. This block can 

be placed by typing Insert and selecting the block.  

The Strung Projects Note is already placed in the key sheet located on the bottom right. 

 

Note The FPID numbers in this note are part of a data field; It will automatically fill in the FPID #. 

TOWNSHIP AND RANGE MAP LABEL 

The Township and Range are used to better describe the area of the project and are located in the Key Sheet file 

as a block. To insert the block for editing simply type Insert or (I) on the command line > Enter and use the 
Name pulldown to find the correct block. 

FLORIDA MAP 

The Florida map is a block within the Key Sheet file that is already placed on every sheet layout in the newly 

created Key Sheet. The Florida Map block is to be located in the upper right hand corner of the key sheet. Refer 

to the Plans Preparation Manual Volume II - Chapter 23.2 for more detail. 

A leader line and text label pointing at the general location of the project are also required. 
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SHEET SET ORGANIZER   

Sheet Set Organizer is a tool developed by the Department to aid in the proper identification of plan sheets in 
a construction set of plans. Sheet Set Organizer will read each sheet and gather information pertinent to the 

electronic delivery process. Sheet Set Organizer can also number and renumber sheets in a set of plans. SSO is 

the final process for delivering plans. Civil 3D has the ability to create sheet sets using Sheet Set Manager 
(SSM). We will go over this process first using the Signalization plans as an example. 

 

When ready to produce a submittal package Sheet Set Organizer will look for all sheet set files (dst) within your 

project folder. This tool will be covered later. 
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Exercise  2.1 Creating a Key Sheet with a Location Map  

 Create the Key Sheet (Part 1)  

 Launch the FDOT Civil 3D State Kit. 

 Refer to Exercise 1.1 if needed for detailed steps on using Create File. From the FDOT Ribbon launch 
the Create File application and using the same project as before with the following settings create a 

Key sheet 

 Discipline – Roadway 

 File Group – Signal Design Files 

 File Type – Key Sheet 

 Output File – KEYSSGXX 

 Output Folder – Signals\ 

 Template – keysht.dwt 

 Template Path – data/templates/ 

 Coordinate System – FL North 

 Select Create/Open 

 With the KEYSSG01.dwg open delete all of the layouts except FF w_Map   

 Right Click on the remaining Layout and Rename to T-1 

 On the FDOT Ribbon click on the Links/Contacts button 

 Click on the CADD Resources pull down and select State of Florida County Maps 

 

 

 

 

 

 

 

 Click on the following pdf file:  

 Save it to your data folder in your project. 

 Click on the Model tab next to your sheet layout. 

 Switch to the Insert Ribbon and select Attach  and browse to the pdf you just saved. 

 The Attach PDF Underlay dialog opens. Your dialog input should look like below. Select OK. 
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 Inserting the pdf to a scale is no longer required, within the viewport zoom into the project area. 

 Switch back to the T-1 Layout and select the Blue Viewport. With the Viewport selected click the Blue 
Lock to unlock the view port and double click inside the viewport to make it active. Zoom Extents so 

you can see the entire map and manually zoom into the vicinity of the project location. When the project 

location looks centered click on the Blue lock to lock the viewport.   

 Notice we didn’t clip the PDF image. We let the Viewport act as the clipping frame. 

 Double click on the End and Begin Project arrows to edit the text. Move the arrows by selecting the label 

and select the blue grip on the arrow end to stretch it to the appropriate location. 

 

  Add the Township and Range Labels (Part 2) 

 Continuing in keyssg01.dwg, type I for Insert and select the block KMLabelTnshp. 

 Make sure you toggle on Specify on Screen and press OK. 

 Repeat steps 1 and 2 for the KMLabelRange entering the data shown on the Key Sheet image. 

 The Township and Range labels are blocks with attributes in them, do not explode the block to edit 
the text. The blocks when inserted open an Edit Attributes dialog which the user can enter in the 

desired information as shown below. 
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 The figure below shows the Township and Range blocks placed on the Key Sheet. 

 

 Now change the layer to TextLabel and draw a leader line and add the text To Panacea  

 Your Location map should now look like the image below 

 

 

 

  Sheet Set Manager (SSM) (Part 3) 

 Type SSM on the command line and press enter to launch Sheet Set Manager. 

 Create a New Sheet Set. The Create Sheet Set Wizard opens. Select An example Sheet set 

and click Next. Browse to the data folder in your project and open the FDOT Master dst file 
to use as the example.   
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 For Sheet Set Details Specify as the above image shows and click Next. 

 Now we will add the Key Sheet to the Signalization Plans Subset. Right Click on the Signalization 
Plans subset and select Import Layout as Sheet  

 

 Select Browse for drawings and navigate to your Signal folder and select the 
KEYSSG01.dwg. The list will contain all sheet layouts that are in the drawing file, since there is 
only one layout in this file it picks it for you as seen below. Select Import Checked to close the dialog. 
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 The fields on the Key Sheet will populate with the data that was created when you created 
the project, if they don’t automatically either Regen the drawing or close and reopen the file.  

 

1. Before 

 

2. After 

 

 To add information to the additional fields so it will propagate to the Key Sheet Right Click on the T-

1 in the subset    and select properties. 

 The list has a scroll bar on the left side, simply fill in the required data > Press OK > and type in Regen 

on the command line for the fields to fill in. 
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 Sheet Set Organizer (SSO)  (Part 4) 

 Close Civil 3D and Save your Keyssg01.dwg.  

 Open Sheet Set Organizer from the FDOT2017.C3D Folder on your desktop. Make sure Civil 3D is 

NOT open before doing the next step. 

 

 Select File > Open Project. 

 Browse to and select your project folder. SSO will now open Civil 3D and look through every sub 
folder in your project searching for all of the dst files you created. 

 

 From here you can publish your digitally signed plan set and you can also edit information such as 

Sheet No, Sheet Title, Layout Name and send the updates back into the drawing file. 

 

 



CREATING A KEY SHEET - Sheet Set Organizer __________________________________________________________ Chapter 2 

FDOT Traffic Plans Course - Signalization ©2017 FDOT 2-11 

 Placing Project Location Label (Part 5) 

In this exercise the student will move the arrow to the general location of the project on the Florida Map. . 

 Continuing in Keyssg01.dwg, zoom to the Florida Map area of the key sheet. 

 

 Click anywhere on the Project Location text as shown above. Three Blue grips appear as shown in the 

above image. Select the Arrow end point and move it to the appropriate location. If necessary you can 

also move the text by clicking on the other blue grips. Press escape to clear the grips. 
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3 SUMMARY OF PAY ITEMS 

OBJECTIVE 

The objective of this chapter is to teach the designer how to create the Summary of Pay Items sheet. 

INTRODUCTION 

The summary of pay items sheet is generated from data outputted from the Designer Interface website, the 

Project Summary of Pay Items and the Proposal Summary of Pay Items. Use the appropriate report, based on 

the project’s phase.  

When the Signalization  Plans are a component of the Roadway plans, the Summary of Pay Items Sheet is part 

of the Roadway plan set and is not included as part of the Signalization  Plans.  

The CADD version of the Summary of Pay Items Sheet is created by a program, TRNS*PORT Sheets that is 

available on the FDOT Ribbon. This tool transfers the AASHTOWare Project Preconstruction Output file data, 
and imports it into a design file, and places it on Sheet Layouts.  

GENERAL INFORMATION 

The TRNS*PORT Sheets tool gives the designer the option to place the reports on an existing sheet layout in 
the design file or to add the sheets into an existing sheet set. The figure below shows how to access the tool. 

 

The figure below shows the TRNS*PORT Sheets tool loaded from the FDOT Ribbon. The dialog is broken 
into two parts; the top portion of the dialog defines the input file. The bottom part of the dialog gives the user a 

choice to add the report data into the design file only or in addition to an existing Sheet set. 
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 Input File Name - The name of the data input file, It doesn't matter where the data file is located 

as long as it is accessible by the file list box. This file should be an XML file, for example: 

22049555201_SG.XML. Click Browse to navigate to the location of the file in your project 

directory. 

 Add Sheets to Sheet Set Toggle - If toggled on user must browse to their project and select the 

appropriate subset.  

Exercise  3.1 Transferring Data to Plan Sheet 

 Summary Of Pay Items Sheet (Part 1) 

In this exercise, the instructor will cover the steps that would normally take place after the designer submits 

the report from the designer interface menu.  These steps will take the designer through accessing the output 

data and setup for the use of the automated process called FDOT TRNS*port.  

 The designer would access the Designer Interface from the FDOT Ribbon option: FDOT Web 
Gate Menu > Designer Interface Link  

 

 . 
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 The designer would Login by typing their User ID in the User Id field and typing in their password in 

the Password field and clicking the Submit button. 

 This will take them to the Trnsport WebGate page. 

 

 Clicking on the Trns*port Reports link will take the designer to the Trns*port Report Menu. 

 

 Clicking the Summary of Pay Items (CADD) link takes the designer to the Summary of Pay Items 
(CADD XML) page. 
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 The designer will select the radio button for either Proposal or Project from the Select Option Type 

section. For this project, the Project radio was selected. 

 The designer will type in the project Financial (Project ID) number in the Enter Project ID section 

field.  The Project ID is 22049555201. 

 The designer will select the radio button for either XML File or Report from the Select Output Type 

section.  For this project, the XML File radio button was selected. 

 The designer will then click the Submit button to submit the request for the output data. 

  Create Summary Of Pay Items Sheet (Part 2) 

In this exercise, the designer will create a new design file and import the TRNS*PORT XML data at one 

time. The Department delivers a tool to automate this process called FDOT TRNS*PORT Sheets. This 
tool can be started from the FDOT Ribbon. 

 Open the Civil 3D State Kit and from the default open drawing switch to the FDOT Ribbon, Click 

on the Create File Application. Select your project. Create the CESSSG01.dwg as shown below. 
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 Select Create Open File. Select Close when drawing is open. 

 From FDOT Ribbon, select TRNS*port Sheets > This opens the FDOT TRNS*port tool. 

 

 For the Input File, select Browse.  

 Browse to the data folder in the project and select the 22049555201_SG.xml file.  

 Click Open. This fills in the Input File name, County Name and the Financial Number in the FDOT 
TRNS*PORT dialog. For Template Layout it is using the Sheet Layout that is already in the design 
file which is named what it is scaled at: 1 Scale. 

 Toggle On the Add Sheets to Sheet Set check box. 

 Browse to the eng_data folder in the signals folder and select the Signalization.dst you made earlier. 
Your dialog should match image below. 
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 Set the Number to 2. This will number the sheet T-2. 

 Click Load Summary of Pay Items and close the TRNS*port dialog 

 Notice the Layout that was created along the bottom of the drawing. 

Exercise  3.2 Update the Signalization Plans Sheet Set (Part 1) 

 Editing the Summary of Pay Items Layout in Sheet Set Manager 

 Close and save the Cesssg01.dwg, type in SSM if the sheet set manager isn’t already open. 

 Open the Signalization dst that was created earlier. Notice the new Summary of Pay Item Sheet in 
the list. 

  

 Right Click on the Summary of Pay Items and select properties. Make the following changes, see 
below. 
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 Regen your drawing for the fields in the layout to update. 

  In the Sheet Set Manager Left click and hold on the T-1- Key Sheet and drag it above the new T-2 

sheet to re order the sheets.  

 Updating Component Index (Part 2) 

 In SSM Right Click on the Key Sheet and select Open. We are going to update the Index on the Key 

Sheet. 

 Right Click on Signalization Plans in SSM and select Insert Sheet List Table 

  

 Select somewhere outside the border for placement of the temporary Sheet List Table. We are going 
to copy and paste the data from the Sheet List Table to the Index on the Key Sheet. The advantage 

of doing this is the fields remain intact.   

 Delete the Sheet List Table that was just placed. 

The advantage of using SSM to navigate between drawing files is that you can open the sheet directly from 

SSM without having the drawing file open, using the example below we have 2 separate dwg files yet we can 

open each up from within SSM. You can also publish your set to pdf or to a printer for a quick check set if 

needed.  

 

 

Note The reason we do not use the automatically generated Index is Civil 3D currently 
does not combine multiple sheets, instead it lists them separately. For Example it will 
list 3,4,5,6, etc. instead of 3-6. 
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4 SIGNALS TOOLS 

CHAPTER OBJECTIVES 

The objective of this chapter is to teach the student how to use Entity Manager, Dynamic Blocks, Place 
Block Group, and Design Center and other Civil 3D tools to create proposed a proposed Signal Design.  

INTRODUCTION 

The Signal Tools section introduces several applications that help the user in the creation of Signals plans.  

As explained in Chapter One of this course material, the designer will create a new file, dsgnsg01.dwg, in which 

the Signals proposed design entities will be drawn. In addition, the designer must reference the proposed 

roadway design file, dsgnrd01.dwg, existing topographic file topord01.dwg, existing utilities utexrd01.dwg, 
existing drainage, drexrd01.dwg, existing and proposed right-of-way files, and any additional files containing 

the existing features along the project.  

After the above is done, the designer is ready to create a clipsg.dwg file which will contain the view frame(s). 

View frames are what Civil 3D uses to create your Sheets.  

The next step is to draw/place the proposed Signal features in accordance with the Department’s CADD 

Standards. The FDOT Traffic Palette provides tools with the active settings (Layer and Symbology) used to 
create the Signal features. There are additional tools available to help in the efficient placement of Signal poles 

and Controller Cabinets on the FDOT Civil 3D Ribbon: Entity Manager and the FDOT Place Block Group 
tool. 

Refer to chapter 24 in the Plans Preparation Manual, Volume II, for more detail on developing the Signalization 

plans. Refer to the Design Standards indexes for design criteria. 

The labeling of the plan sheet items can be completed by using the Add Labels Button on the Annotate Ribbon, 

which allows the designer to use/edit/create styles for the placement of repetitive labels. 

Finally, the designer must compute the pay items used and populate the Tabulation of Quantities Sheet. FDOT 
Takeoff Manager can calculate and report every “each” and “linear” item. FDOT Takeoff Manager generates 

a report that can be polished in Microsoft Excel, which can then be imported into the Civil 3D Tabulation of 
Quantities design file using Civil 3D’s DLM (Data Link Manager). 

CREATING VIEW FRAMES FOR SIGNAL PLAN SHEETS 

Creating View Frames for Signal Plan Sheets is different than for Roadway or Signing and Pavement Marking 
Sheets. Unlike Signing and Pavement Marking plans there may only be one Signal Plan sheet depending on the 

number of intersections. The user will use Civil 3D to Create View Frames and then create a data shortcut 
of the View Frame that can be data referenced into the design file to layout and clip the sheet(s). The 

scale should not be smaller than 1” = 50’. 

If a Motif file is used, this should be set up prior to starting the clipping process. A Motif file is basically a Civil 
3D file with all of the reference files attached that the user wants attached to each plan sheet.  

In this section, the student will learn how to use the Create View Frames Wizard to create view frame(s) and 
create data shortcuts to bring in the view frames to the clipsg.dwg. As with any process, it is important 

to communicate with the Department’s Project Manager to make sure that all district specific requirements 
are addressed i.e. Match Lines or no Match Lines, Grey Scaling existing features and so on. 
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CREATE VIEW FRAMES WIZARD 

From the Civil 3D Output Ribbon click Create View Frames. The wizard will not start unless you have an 
alignment in your current file. This is the first of two steps in creating a finished Layout sheet with the FDOT 

Border that you will add to your plan set. 

 

Once activated, the View Frame Wizard opens. As you can see on the left pane of the wizard it has pages that 

you walk through and input required parameters. The Blue arrow indicates which page you are on. 

ALIGNMENT PAGE 

The first page is the Alignment Page. There is an alignment list pull down bar to choose from a list or you 
can pick the green select in drawing button. The default Station Range is the entire length, however you can 

also switch to user specified to type in the station or using the pick button select from the drawing the station 

range.  

 

 

 

SHEETS PAGE 

The second page is the Sheets Page where you select either Plan or Plan & Profile. The department provides a 

folder of ready to use template files that contain Plan, Profile, Plan & Profile, Section sheets, Etc. They are 

located here       
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The second part of the page is the View Frame Placement where you select how the view frames will be rotated 

along the alignment. FDOT workflow recommends you rotate Along Alignment. 

 

VIEW FRAME GROUP PAGE 

The View Frame Group page is where you give your View Frame Group a name and description. To edit 

how and what is labeled you can edit the naming template by clicking on the drafting graphic to the right 

of the Name box.  

The rest of the page deals with styles that will be used for your View Frame Group. The department provides 

pre-set styles that will auto populate your wizards which are set through command settings.  

 

MATCH LINES PAGE 

The Match Lines Page deals with how you want your match lines to overlap or not, Layers, Match Line 

Styles and Match Line Label Styles.  

When all missing parameters are filled in select Create View Frames and the frames will be placed along 
the alignment in the drawing file. 
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CREATE SHEETS 

Create Sheets  provides the method to take the view frame and combine it to a FDOT Sheet Border to 
make a layout sheet to add to your plan set.   

Once activated, the Create Sheets Wizard opens. As you can see on the left pane of the wizard it has pages that 

you walk through and input required parameters. The Blue arrow indicates which page you are on. The Grayed 

out pages represent not used or available.  

  

VIEW FRAME GROUP AND LAYOUTS PAGE 

View Frame Group – Chose the view frame group that exists in your drawing either created in the drawing or 

from a data shortcut. You can use the pull down or select from the file. The sheet type selected when the view 

frame was created is displayed. You have a choice of selecting all view frames or manually selecting frames. 

Layout Creation - From here you can control the number of layouts per drawing, put them in a new drawing, 

or in the current drawing. You can name your layouts now or you can rename after you create them. IF a North 

Arrow is required chose the block to use here. 
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VIEW FRAME GROUP AND LAYOUTS PAGE 

Sheet Set – You can either create a new sheet set (dst) or add to an existing sheet set, make sure you specify 

the location within your project for the sheet set, They should be stored in your eng_data folder. 

Sheets- This area is only active if you are creating layouts in new drawings. If you chose to create layouts in 

the current drawing, the area will be inactive. Type the path or browse to the folder where the sheet files will 

be located. If you are using Autodesk Vault the Vault Icon will be highlighted for use. The Sheet File Name 

controls the naming template of the sheet files. 

 

 

When all options are filled in select Create Sheets to create your new layout(s) 
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Exercise  4.1 Create View Frame and Sheet Layout 

 Create View Frame (Part 1)  

In this exercise, the student will create the View Frame and save it as a data shortcut. 

 Create and Set up the Clipsg design file 

 Starting from the default drawing click on the FDOT Ribbon, select Create File  to open the Create 
File application. 

 Using what has been learned in this course guide, create the Clip Borders file. Create/Open the file 
in the Signals folder using the Signal Design Files Group. Refer to chapter 1 in this training guide 

for assistance if needed. Close the Create File application. 

 In the Data Shortcuts on Prospector, expand the Alignments and right click on US98 and select 
Create Reference. The default styles that will be used are already set. Click OK. 

 

 

 Using what you have already learned creating Xref’s type Xref in on the command and reference the 

following files as overlays: dsgnrd01.dwg, dsgnsp01.dwg. Zoom Extents to see the references. 

 Switch to the Output Ribbon and start Create View Frames. 

 On the Alignment Page set the Station Range to User Specified and type in 30+50 to 35+40, you 
can roughly pick in that range also. Since we only want one View Frame we don’t want to use the 

default Alignment length since that would put multiple View Frames in our drawing file. Keep in 

mind you can edit the View Frame after placement. 

 Click Next to advance to the Sheets Page. Select Plan Only for Sheet Type. For Template for Plan 
Sheet select the Ellipse button to browse to the following location and pick the SHPLAN.dwt. When 

the scale dialog comes up select 40 Scale. See Image Below. 
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 Still on the Sheets Page, toggle on Along alignment for View Frame Placement. You can also control 

if you need the view frame to start before the alignment. Click Next. 

 On the View Frame Group Page. Give it the name and description as shown below. 

 

 Click Next to advance to the Match Lines Page. Since we don’t have any matchlines toggle off the 

Insert Match Lines. Notice all options are grayed out now. Select Create View Frames. Your 

clipsg01.dwg should look like below. 
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 Save your file > Right Click on Data Shortcuts > Create Data Shortcuts 

 

 Select the View Frame Group that is listed. This dialog will populate with all available Shortcuts that 
can be saved to the _Shortcuts Folder in your project. Select OK to execute. 

 

 

 View Frame Setup (Part 2)  

 Data Reference or Dref’s 

 Open or switch back to dsgnsg01.dwg. On Prospector expand the View Frame Groups located 

in the Data Shortcuts tree. Right Click on the Signal Design Int.1-40Scale-US98  > Create 

Reference 
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 The Create Reference Dialog Box opens. Take a moment and look at the settings and available styles 
in the image below. Your dialog should match. 

 

 Select OK. After a moment you should see the View Frame that you created previously at the 
intersection. 

 Create Sheet Layout and Adding to Sheet Set (Part 3) 

 Sheet Layout 

 Start Create Sheets from the Output Ribbon.  This can also be loaded from typing it in on the 
command line. 
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 On the View Frame Group and Layouts page make sure you have the correct View Frame Group 
selected > Put the Sheet in the Current Drawing > Enter in the Layout name. If you don’t know 

the sheet number you can always edit the properties after creation. 

 Select the Block used as the North Arrow. The North Arrow will rotate in each sheet to orient to 
North. Click Next. 

 

 

 On the Sheet Set Page browse to the already created DST file as shown above.  

 Click Create Sheets. 

 The Signalization Plans Sheet set should look like the image below. We need to make some obvious 
edits 



Chapter 7 ____________________________________________ SIGNALS TOOLS- Creating View Frames For Signal Plan Sheets 

3-18 ©2017 FDOT FDOT Traffic Plans Course - Signalization 

 

 First Left Click on the new sheet and drag it up to the Signalization Plans Sheet set. Then Right Click 
and remove subset as shown below 

 

 Right Click on the new sheet > Properties and make the changes as shown below. So far the new 
Sheet set has 3 separate drawing files that can be accessed in one convenient spot.  

 

 Switch to the new Sheet Layout tab. Double Click inside the viewport to make it active. Notice the 

following items 

 The North Arrow is already rotated and scale is listed. 

 The view inside the viewport is already rotated (click on the model tab to 

compare). 

 The scale is already set to 1”=40’. 

 The fields in the sheet border are already filled in. 
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Exercise  4.2 Signal Head Detail  

 Place Signal Head Details (Part 1) 

In this exercise the student will use the FDOT Traffic Palette to place the Signal Head Detail. 

 Continuing in dsgnsg01.dwg,  

 On the Home Ribbon select Tool Palettes if they are not already displayed.   

 Right Click on the Palette Name and select FDOT Traffic. 

 Select the Signal Heads tab.  

 Make sure your Sheet Layout is in Paper Space.  

 Scroll down the palette and select the block (5Sect1WayLHz) 5 Section 1 Way Left Horizontal 

(650-1-18)   

 

 Left Click to place anywhere in the top left corner of the sheet. 

 The Edit Attributes dialog opens. Enter in 4 for the assembly count. You can always edit this later 

by double clicking on the block or selecting and right click > Properties. Select OK. 

 

 On the palette select the block (3Sect1WayHz) 3 Section 1 Way Horizontal (650-1-14). 

 Place it next the previously placed signal head detail. For Assembly count enter 2. 

 Drawing should look like below. 
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 Place Detail Text (Part 2) 

In this exercise the designer will place the description text “SIGNAL HEAD DETAIL” above the two signal 
heads placed in the previous exercise. This note is bigger than normal text so the user will have to set the 

text height manually. 

 

 Continuing in dsgnsg01.dwg, type in Mtext on the command line and draw the text box as shown 

below. 

 

 You can set the text height before typing or highlight the text and make edit using the Text Editor 
contextual ribbon. In this case change the text height to .10 and toggle on the underline symbol. The 

font is still annotative as you can see the blue drafting triangle in the text style pick box. 
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 In the Text box type in SIGNAL HEAD DETAIL and left click outside the text box to exit the 

Mtext editor and place the text. 

 Place Controller timing and Loop Detector (Part 3) 

This exercise is placing the Timing Charts for Controllers and Loop Detector Charts. Make sure to remain 

in paper space. 

 Continuing in dsgng01.dwg on the Traffic Palette switch to the Signal & Lighting Tables tab. 

 Click on the Controller Timings table to insert it in lower left corner of the drawing file. 

 Click on the Detectors for Loops Table and insert it in the lower right corner of the drawing file.  

 Both of the objects are AutoCAD Tables and are ready for user input.. 

Exercise  4.3 Mast Arm Assemblies Sheet  

 Create Mast Arm Assemblies Sheet (Part 1) 

In this exercise the user will create the Mast Arm Assemblies sheet and place the standard notes and table. 

 From the FDOT Ribbon, select Create File.  

 

 Fill in your options matching the image above. 

 Click Create/Open. Close dialog when file opens in the background.  

 The file is already created with a sheet border and is set to 1 Scale since we will be working with 
details which will be placed in paper space. 
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 Use the Traffic Palette to Place the Standard Mast Arm Assemblies Data Table (Part 3) 

 Change the Layer to Tables_dp then From the FDOT Traffic Palette, select the Signal & Lighting 
Tables tab > select the Mast Arm Assemblies Data table.  

 Insert in the top center of the sheet. 

 Fill in Table (Part 2) 

The AutoCAD table can be filled in with data. An AutoCAD Table behaves like an Excel File. 

 Zoom to the table, enter the appropriate data and save the file. 

 Structure Assembly Numbers First Arm/Arm Type Pole/Pole Type     Pole/UB (ft.) 

 1   E3-T2   E3   T2  20 

 2   E5-T3   E5   T3  20 

 3   E6-T4   E6   T4  20 

 4   E5-T3   E5   T3  21 

Notice when you insert the Mast Arm Table the Mast Arm Assembly Data Notes are already 

included as a block within the table. You can edit the notes by double clicking in the block. The Gray 

border on the table does not print. Your drawing should look like below. 

 

Exercise  4.4 Mast Arm Tabulation Detail Sheet (Part One) 

 Create New File 

 Using the Create File application from the FDOT Ribbon, select Create File. 
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 Select Create/Open to create the Pole Tabulation and Details for all Types file. 

 Close the Dialog. 

 Like the other detail sheet the current drawing file has a 1 Scale Layout and is set in Paper Space.. 

 Using the Traffic Palette to Insert the Standard Mast Arm Tabulation Table (Part 2) 

 Change the current Layer to Tables_dp.  

 With FDOT Traffic tool palette selected click on the Signal & Lighting Tables tab. 

 Select the Mast Arm Tabulation table to insert it in the drawing. Insert it in the lower left corner of 

the drawing. 

 In the drawing file, enter the appropriate data and save the file. Please see images below. 
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 Place the Standard Mast Arm Assembly Data Table Notes Block (Part 3) 

 From the command line type in Design Center (DC) and press enter. Make sure you are still in paper 
space. 

 Using Design Center browse to the Block folder within the state kit. 

 Expand the Roadway drawing and select Blocks. 

 

 Locate the SHMastArmTabulation block and Right Click > Insert Block. 

 

Note The origin of this block is positioned at the top left corner of the plan sheet. 

 Sheet Set (Part 4) 

 Using what you learned earlier add this sheet to the Signalization DST file. Rename the Layout to 
Mast Arm Tabulation. 

 Save Drawing. 
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STRAIN POLE SCHEDULE  

Creating the Strain Pole Schedule sheet is a little different in Civil 3D, since you can have multiple sheet layouts 

in one drawing it is easier to copy the Standard Mast Arm Tabulation Layout the same way you would copy 

a tab in Excel. And using what you have already learned place the Tabulation/Summary Boxes that would be 

linked to the Excel spread sheet with the Strain Pole Schedule data. After the data is link to the 

Tabulation/Summary Boxes, the designer would place the Strain Pole Schedule Details & Notes block 

(SHStrainPoleSchedule) on the Strain Pole Schedule sheet. Finally, the designer would update the Strain Pole 

Schedule sheet layout with Sheet Set Manager. 

EXPLORING ENTITY MANAGER (EMX) 

Entity Manager or EMX uses a proprietary database that is provided by the Department. When the 

Department’s CADD software is installed, the latest EMX database is placed on the local hard drive. When new 
projects are started and EMX loads for the first time it will ask you to save a Payitemdb.xml file. This will be 

your projects Database file that contains the current Payitem data., it is recommended to save the latest 

PayitemDB file from the Department’s default folder to the project SYMB folder and rename it to the eleven 

digit FPID number.  For the 22049555201 project used as the example in this manual, the PayitemDB.xml is 

renamed to 22049555201.xml. This allows the designer to modify the database for specific parameters, and 

protect it from being overwritten by any future maintenance updates. The original version of the 
AECMERGE is delivered with the FDOT C3D software suite as [Device]:\FDOTXXXX\Data\Pay 
Item Data\AECMERGE.XML and is automatically loaded and updated by EMX.    

When EMX Manager is opened during a drawing session it can be 
minimized or closed and reopened again in the same session. If you 

close your civil 3D session with EMX open it will remember if it 

was opened or closed and load accordingly. 

It is highly recommended that every user that works on projects 

becomes very familiar with Entity Manager. Entity Manager 
should be the standard tool used by everyone whether they are 

drawing simple lines, placing blocks, or designing major 

interchanges. Other applications and processes rely on the X-data 

that EMX places on entities, if these features are not found then 
quantifying, for example, would be impossible. 

This database has been set up specifically by the Department to 

create entities with the correct Layer symbology according to the 

Department’s CADD Standards. The AECMERGE.xml file is set 
up with discipline folders called categories. Inside of each category 

are items.  

 

o Pay Item Categories - The basic component of the hierarchical tree is the Category. The 

AECMERGE.XML database categories are divided by discipline. The figure above shows the 

Categories with a description relative to their discipline.  Inside these Categories, you have either 

subcategories or items. Items are represented by one of three icons as described below.  

o Items - The other database component is the item. An item could be a drafting item, a compute 

item or a default item. Items contain specific functions related to defined entity symbology or 

quantity calculations. Items are represented by one of two icons: 

o   Paintbrush Icon – This symbol reflects that a compute formula is not assigned but entity 

can still be drawn or placed with correct symbology. 
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o   Calculator Icon with Red Check – In addition to having a compute method and correct 
symbology this symbol reflects entities that have Adhocs that can be added.  

o     Calculator Icon – This symbol reflects that entity contains no Adhocs. 

EMX MENU BUTTONS 

EMX has a toolbar to quickly access different modes. The function of each button is summarized below.  

 

 - File View – This section allows user to save, save as, export or open a project specific 
database. The default option allows user to rebuild the project database with default settings.  

 - Identify Item. Identifies and displays (Pay Item Data) XData for a selected entity. The entity may be 

preselected or selected after the tool is activated. The tool works with one entity at a time. 

 - Appends. Appends XData to select entities. Most common entities - arcs, lines, circles, feature lines, 

rectangles and others are included.  

 - Replace. Replaces XData to select entities. These entities must already contain pay item data to be 
selected. 

 - Region. Creates a hatched region from an enclosed area. The region is appended with XData and a label 

is also created. The boundary for the region should not have XData attached. The region is used for quantifying.  

 - Remove. Removes XData from selected entities. The entity may be preselected or selected after the tool 
is activated.  

 - Edit. Displays Edit Entity Attributes/Adhocs dialog for the selected entity. The entity may be 
preselected or selected after the tool is activated. 

 - Match Properties. Transfers the properties and XData from a source entity to one or more target 
entities. The entity may be preselected or selected after the tool is activated. 

 - Label Tools. This opens the Hatch Area Labels dialog. This dialog configures the label used when the 

Region command is used to enclose regions and attach XData. 

 -   Highlight/Show Tools. The Highlight/Show tools work with the entities found in the primary drawing 

file and currently do not work with X-Referenced files or Data-Referenced entities. 
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DESIGN SETTINGS 

Settings used while using EMX are based on how your Civil 3D environment is set up. The department has set 

the State Kit up to be a By layer standard, meaning that all Colors, Linetypes, and Lineweight are controlled by 

the Layer Property. All symbology is set by the Master Standard spreadsheet that resides in the state kit install 

folder. 

DESIGN MODE 

Design Mode is the default mode when the EMX is opened. Design Mode is used for the following functions:  

 Sets Symbology Standards by use of the Drawing Tools on EMX for the placement of 

AutoCAD entities. 

 Place Adhoc Attributes on an entity. 

Items are placed in the file by generic AutoCAD commands using the EMX Drawing tools, the items can be 
placed as pay items for future tabulation.  

The Drawing tools as shown below are used to Place Entities with Influence, which is another way of saying 

it attaches the Xdata used to extract quantity reports.   

 

When a command is started using the drawing tools the FDOT Civil 3D Layer symbology is set.   

It cannot be stressed enough how important it is to NOT use regular AutoCAD commands to draw or place 

Entities, they will not have the required Xdata attached and you will have to append appropriate Xdata to them. 

ADHOC ATTRIBUTES 

An Adhoc Attribute is additional information about a particular entity. Look at it as just another property for the 

drawing entity. Example, a line has this fundamental data associated to it:   

Layer, Color, Lineweight, and Linetype. 

By placing an Adhoc on the line the designer is giving that line additional information. That information could 

be a chain name, cross slope, profile name, thickness, etc. It is almost limitless as to what can be associated to 

an entity with Adhocs.  

AdHoc Attributes are comprised of three types of information that must be defined:  

1. Name - The Name is an identifying term.  

2. Type - The Type identifies the nature of the information, and can be set to various options: 

Numeric, String, Unit, Quantity, and Remarks. 

3. Value - The Value is the actual information to be used by FDOT Takeoff Manager, and is 
determined by the Type. For example, if the Type is set to Numeric then the Value must be a 

number. 

DRAWING SIGNAL POLES 

Generating the proposed Signal design is the responsibility of the engineer. The Department has developed a 

workflow to help simplify the process. One method is to place the pole using the dynamic blocks, another 

method is to place the signal blocks using Place Block Group which will attach the appropriate Xdata to the 

object. The other method is to use EMX to place the block. 
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DRAWING OTHER FEATURES 

Pull boxes, Conduit and Loop Detectors are also important parts of the Signal plans. In this course the designer 

will learn how to place these entities using EMX, Place Block Group, & Design Center. The designer will 
also learn how to attach an AdHoc attribute on the signal poles for use in generating automated quantities. 

PLACE BLOCK GROUP  

Another option the designer has to place the light poles, directional arrows, RPM’s etc… is the Place Block 
Group tool located on the FDOT Ribbon. This tool works well when placing multiple blocks at one time. 

Note When using the Place Block Group you will be browsing the same database that is used in EMX.  

The Place Block Group tool can be loaded from the FDOT Civil 3D Ribbon on the Pay Item Tools panel.  

This tool can also be loaded from the Command Line by typing blckgrp. 

 

 

BLOCK GROUP TAB 

Defines the EMX Manager item to use which in turn selects the block to be placed, the Offset, and Upstream-
Downstream spacing from the selected entity to place the item. 

 

Based on the items that are checked the designer can place up to three different blocks with this tool. The 

Magnifying glass next to each item allows the designer to browse to the EMX database and select the 

appropriate item which will attach the block to be placed. The Offset is the distance off of the selected drawing 
Entity or Xref Entity when placing the block.  

LOCATION TAB 

Defines what object the designer selects to place block, Line, Polyline, Alignment, or Xref Entity. Begin and 

End stations and Spacing. 
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o Entity – This can be a Line, Polyline, Arc, Alignment, or Xref Entities. This functions just like the 

Draw Striping tool. The Begin and End station will be populated with the entire length of object 

selected. They can also be modified using the buttons or by keying in the value. 

o Buffer Distance – This is for setting where to start the first block and end the last block.  

o Spacing – There are several options available to set the spacing between the blocks, they are: 

o Increment – This is a set value between blocks. 

o Even – Evenly spaces the blocks at a specified spacing, the buffer distances are ignored. 

o Max Spacing – The location of the beginning and ending block are determined, then a sufficient 

number of blocks are placed in between, so that the distance between them is no more than the 

specified Max Spacing. 

o Once – Only one set or block is placed. The ending buffer distance is ghosted. 

o Each Vertex – The origin of the block is placed at each vertex of the selected entity. The Begin 

and End and buffer distances are ghosted. 

o End Points – The origin of the block is placed at each end point of the selected entity. The Begin 

and End and buffer distances are ghosted. 

o Angle – If set to Absolute the angle is based on 0 degrees as horizontal. If set to Relative the block 
is placed relative to the entity selected. 

o Justification - The justification can be based on the center block (only option if only one row is 

placed), the upstream or downstream block.  Only those toggled on in the Block Group Tab are 

available for setting Justification. 
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REVIEW EMX SIGNALS ITEM 

Before placing the Signals items it is important to understand 

how they are set up. The AECMERGE file that the Department 

delivers will have blocks assigned to the Signal items to assist in 

the production of plan entities. The advantage to using EMX to 
draw the mast arms and other Signal entities is that the entities 

can be automatically quantified. The figure to the right shows the 

Mast Arm item in EMX. 

 

 

 

 

 

 

 

 

 

 

 

 

Exercise  4.5 Placing Signal Poles using Dynamic 

Blocks  

 Placing Signal Poles using Dynamic Mast Arm assemblies  (Part 1) 

In this exercise the student will place a Mast Arm Signal Pole at a specified station and offset. The dynamic 
mast arm assemblies contain the Mast Arm Pole along with the Mast Arm. A visibility state with options is 

available for each block. The  symbol designates blocks that are dynamic. 

 Load or create the Payitemdb.xml and Select mast Arm Item 

 Open the Dsgnsg01.dwg and ensure the following reference files are attached: 

 Dsgnrd01.dwg from the roadway folder as an overlay.  

 Dsgnsp01.dwg from the signing folder as an overlay. 

 Make sure the Following is Data Referenced in 

 Alignment - CL98  

 View Frame Group – Signal Design Int.1-40Scale-US98 

 Click on the T-3 SIGNALIZATION PLAN layout. It is already centered near station 33+00 on the 

CL98 alignment. This is at the intersection. 

 Use the Xref Manager to unload the Display of the Dsgnsp01.dwg to clean up the area around the 

intersection. 

 Open EMX  , if closed. 
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 From EMX click File > Open and browse to the project symb folder. 

 Select 22049555201.xml. This is the AECMERGE file copied from the FDOT2017.C3D folder and 

renamed. 

 Click OK to load the file. It should now appear in EMX as shown below. 

 

 Using FDOT Traffic Palette to place block 

 The first pole to be placed is Pole 4 (The South West Quadrant of the Intersection). From the FDOT 
Traffic Palette > Mast Arms/Assemblies tab select the following block MAPole1Arm(130).  

 Using the Station Offset Transparent Command  which is located along the right side of your 
drawing space. 

 The command line will ask for the Alignment. Select the US98 Alignment 

 The command line will ask for the Station. Enter 3232, be sure not to enter station values with the 

+ symbol.  

 The command line will ask for the Offset. Enter 62.28.  

 The block is placed but is not rotated correctly. Using the following Osnap settings, type in RO for 
rotate > Press Enter > select the block > Press Enter > For Base Point select the Geometric Center 

of the Pole. 

          

 With the Perpendicular Osnap enabled you can select the SR61 Alignment as the object to snap to 

since it is Perpendicular to the intersection. 

 

 The type needs to be changed with the correct Pay Item. Select the block. There are two blue grips 

visible now. 
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 Click the Left Triangle grip and from the pull down select the MAPole1ArmT3-E5 w/o Luminaire 

0649 31203. Each block contains visibility states which allows the block to change to the correct size 

and pay item number. Once selected notice the block has changed in size. 

 

 Repeat steps 9–18 for Poles 1-3 using the same block with the data shown below. Rotate Mast Arm 

direction as needed. (Please see the BOE for payitem detail): 

Note Remember to enter station values without the + enter as 3258.04. Left offset values should be entered 
as a negative number (i.e. -41.47) 

Pole Pay Item                                                                  Station    Offset/Direction  

Pole 1 0649 31202 Single Arm without Luminaire (E3)  32+58.04 -41.47(Left)  

Pole 2 0649 31203 Single Arm without Luminaire (E5) 33+59.34 -56.27 (Left) 

Pole 3 0649 31204 Single Arm without Luminaire (E6) 33+49.31 63.11 (Right) 

Your intersection with all four Mast Arm assemblies should look like image below. Notice the Pole number 

designations. You will use this as a reference in later exercises. 

 

 Save the File before continuing. 

PLACE SIGNAL HEAD 

The Signal Head can be placed using EMX.  The advantage of using EMX is the ability to quantify the items 
automatically.  
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 Place Signal Head (Part 3) 

In this exercise the designer will place a Signal Head on the Mast Arm using EMX. 

 Place Signal Head 5 section 1 Way 

 Continuing in Dsgnsg01.dwg, Pole 4, zoom out so the entire intersection is in the view.  

 Open EMX if it is closed. 

 In EMX, using the Pay Item Categories navigate to Signalization > Traffic Signals > Furnish & 

Install. 

 Scroll to find 0650 1 18, Traffic Signal, F&I, Aluminum, 5 Section, 1 way > 5SHORAL, Traffic 

Signal, F&I, Aluminum, 5 Section, 1 way. 

 Right click on item 5SHORAL, Traffic Signal, F&I, Aluminum, 5 Section, 1 way and select Insert 

Block. 

 

 

 Using the nearest NEA osnap, snap along the Mast Arm. Don’t worry about the rotation since we 
will rotate the signal head to match the Mast Arm. Right Click to close command. 

 Select the Signal Head Block > Click the Grip > Right Click > Rotate > Snap to NEArest along 
the mast arm. The Block is now aligned with the Mast Arm. 

 Select the block again and select the Grip > Slide the block down the mast arm. Notice the NEArest 

osnap keep the block stuck on the Mast Arm. See image below for final location.  

 Place Signal Head 3 Section 1 Way 

 In EMX, navigate to Signalization > Traffic Signals > Furnish & Install. 

 Scroll to find 0650  1 14, Traffic Signal, F&I, Aluminum, 3 Section, 1 way > 3SHORAL, Traffic 

Signal, F&I, Aluminum, 3 Section, 1 way. 

 Right click on item 3SHORAL, Traffic Signal, F&I, Aluminum, 3 Section, 1 way and select Insert 

Block 
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 Snap to the Mast Arm and Rotate it like you did the other Signal Head. Your Drawing and Pole 4 

should look like below. 

Note You may need to draw a temp construction line marking the center of the opposing Lanes so you can 
center the Signal Heads. 

 

 Repeat steps 2-12 to complete placing signals heads on Mast Arm Assembly Poles 1-3: You can 

also copy the Blocks as the Xdata copies along with it. 

Pole Mast Arm Block  Signal Heads  

Pole 1 Mast Arm Type E3  5 Section, 1 Way & 3 Section, 1 Way   

Pole 2 Mast Arm Type E5 5 Section, 1 Way & 3 Section, 1 Way  

Pole 3 Mast Arm Type E6 5 Section, 1 Way & 3 Section, 1 Way 

Refer to completed Signal Head Placement image below for final location.  

 

 Place Signal Head Number 

In this part of the exercise the designer will complete the Signal Heads by placing a signal number. The 

next figure shows the finished product. 

 

 In Civil 3D, set the Current Layer to SignalHead. 
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 On the Signal Blocks Palette Select SignHdNo which is the Signal Head Number block. 

 Position the Signal Head Number Box center, front of the arrow on the 3 Section, 1 Way Signal 

Head. 

 When you select the insertion point an Edit Attributes dialog box opens. Enter 8 for Field 1. 

 

 Rotate the Block to be parallel to the Signal Head, using the PERpendicular osnap snap to the SR61 

Alignment  as show below. 

           

 Place or Copy 2 Signal Head Number Boxes on the 5 Section, 1 Way Signal Head offset from 

center, but both boxes centered about the Signal Head.  

To Edit an already labeled Attribute Double Click on the Block.. 

 Repeat steps to fill in the 2 Signal Head Number Boxes for the 5 Section, 1 Way Signal Head. 
Click inside each Signal Head Number Box for the 5 Section, 1 Way Signal Head. The first box 

enter the number 8. The last box enter the number 3. Drawing should look like below. 
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 Repeat steps 14-20 to place the Signal Head Number Boxes and use the Edit Attributes to fill in the 

data on all the Signal Heads Number Boxes for each pole with data in the table below:  

Pole Mast Arm Block  Signal Heads  Box 1 Box 2  

Pole 1 Mast Arm Type E3  3 Section, 1 Way   2 

Pole 1 Mast Arm Type E3  5 Section, 1 Way   2 5   

Pole 2 Mast Arm Type E5 3 Section, 1 Way  4 

Pole 2 Mast Arm Type E5 5 Section, 1 Way  4 7  

Pole 3 Mast Arm Type E6 3 Section, 1 Way  6 

Pole 3 Mast Arm Type E6 5 Section, 1 Way  6 1  

 

LOOP ASSEMBLIES 

The loops, like the signal heads, can be placed with Civil 3D tools and from EMX . The advantage to using 

EMX is the ability to tag the item with Xdata. The Figure below shows the Loop Assembly for a Type F loop. 
Like the other Block placement you will need to rotate the Loops.  
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Exercise  4.6   Place Loop Assemblies 

In this exercise the designer will continue working in the same intersection and place the Loop Detectors, using 

EMX, that correspond to the Signal Heads placed in the previous exercise. Refer to Design Standard index 
17781 for additional design criteria for Loop Assemblies. The figure below shows the Loop placed 2’ behind 

the stop bar centered in the turn lane. 

 

 Place Loop Type F 

 Continuing in Dsgnsg01.dwg reload Dsgnsp01.dwg from the Xref manager. 

 Zoom in near station 34+00. 

 Open EMX and navigate to Signalization > Loop Assemblies > Furnish & install. 

 

 Scroll to find 0660 2106 Loop Assembly, F&I, Type F > LoopF50 Loop Assembly F&I, Type F 
(50’) and Right Click > Insert Block. 

 Snap to the midpoint of the stop bar centered in the Turn Lane and Left Click.  

 The command line is asking for the rotation angle > PERpendicular snap to any of the alignment 

tics. See Image below for snap graphics. 
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Note If you accidently rotate it to the wrong angle, you can always type U for Undo. 

 When the Edit Attributes dialog opens enter -5 after L > Press OK. 

 

 Move the Loop Block 2’ behind the stop bar by selecting it > Click the Blue Grip > Zoom in and 

Move it until the NEArest osnap highlights on the Loop itself  > Type 2 > Enter. 

 

 Loop should look like below. Save your File. 
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 Place Multiple Loop Assemblies 

In this part of the exercise the designer will place multiple loop assemblies to complete a leg of an intersection 

using a different technique. When complete your drawing should look like below. 

 

 Continuing in Dsgnsg01.dwg zoom in near the south side of the Intersection. 

 First draw 2 temporary circles 6’ in diameter with the center at the end of the lane lines at the stop 

bar. 

 Draw a Line Perpendicular to the Lane Lines. We will use these objects as references. 

 Open EMX and navigate to Signalization > Loop Assemblies > Furnish & install. 

 Scroll to find 0660 2106 Loop Assembly, F&I, Type F > LoopF20 Loop Assembly F&I, Type F 
(20’) and Right Click on item LoopF20 Loop Assembly F&I, Type F (20’) and select Insert Block.  

 For Insertion Point Select the Intersection of the first circle and the Stop Bar. This is the Center of 
the Travel Lane. 

 For Rotation Select the PERpendicular osnap of the Temporary Reference Line. 

 Press Ok when the Edit Attribute box comes up. You will edit the three fields when all are in place. 

Your Drawing should currently look like below. 

 Scroll to and Insert the 0660 2101 Loop Assembly, F&I, Type A (20’) The insertion point is the 

middle lane as shown below. 

 

 Using the AutoCAD Copy command select the Middle Loop A(20) and using the Circle Intersection 

with the Stop Bar as a base point snap to the third yellow highlighted location as shown above.  
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 Select all of the loops and move them down 2’ snapping to the NEArest osnap. 

 Going Left to Right double Click on the Loop Blocks and fill in the following; L-7, L-4, L-4. If you 

haven’t already delete your reference line and circles. Your drawing should look like below. 

 

 

 

Note If you haven’t noticed yet, there is a visual difference between the two images above. The bottom one 
which is thicker and realistic to how the drawing will publish has the Line Weight option turned on. 
What this means is that it will display the assigned Line Weights that are assigned through the Layer 
Properties when you created your file which meets the Department Standards. 

 

 Repeat steps to place the 0660 2101 Loop Assembly, F&I, Type A in the Left Turn Lane on the 

West Side of the Intersection.  

 You can also copy and mirror the already placed Loops. 

 Copy and Mirror the Appropriate Loops to the North Intersection. 

 Enter L-8 and L-3 in the Loop Fields. The North Side of Intersection when complete as shown 
below. 
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 Enter L-1 in the Loop Field. The West Side of Intersection when complete as shown below. 

 

 Next using EMX browse to Pay Item Number 0660 2102 Loop Assembly, F&I, Type B and select 
the Insert Block Icon on the Drawing Tools Tool bar along the bottom. 

 Select the Station Offset  Transparent Command located along the right side of your drawing 

screen. Transparent commands are used inside another command to allow the user to place objects 
with precision using Civil 3D Objects.   

 The command line will ask for you to select an Alignment. Select US98. 

 A Red Jig will appear on the screen locked to the Alignment. The Command Line will ask for the 

Station. Type in 3066.42. Note that you don’t enter in the + symbol when typing in stations. 

 Notice the Red Jig is now locked on the Alignment at the Station you entered. For offset enter 12.56.  

 Using the above steps insert the same block at Station 3532.09, Offset -12.46. Note that the negative 
offset denotes Left Side placement. 

PULL BOXES 

Inserting the Pull Box items using EMX works much like the Loop Assemblies. As with any item being placed 

with EMX it is good practice to review the item to better understand how the item is placed. If the designer 
places the Pull Boxes using AutoCAD inserting methods the items will not have the appropriate Xdata attached 

to allow for Quantities reporting. 
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Exercise  4.7 Place Pull Box 

In this exercise the designer will use EMX in conjunction with AutoCAD Commands to place several pull boxes 
around the intersection. By using EMX, the designer will be able to generate automated quantities.  

 Continuing in Dsgnsg01.dwg, zoom in near Pole 3. 

 Open EMX if it is closed. Make sure the correct Payitemdb file is loaded. 

 In the Pay Item Categories Navigate to Signalization > Pull and Junction Boxes. As Shown above. 

 Click on Item 0635 2 11 Pull and Splice Boxes, F&I, 13" 
x 24".   

 Click on the Insert Block as shown on Image to Right. 

 Type R for rotate > press enter > and using your end point 
osnap select Left to Right the two Lane Lines at the Stop 

bar as shown. The reason we rotated using these two objects 

is to rotate the block to the view orientation 

 

 Select the Station Offset Transparent Command   on the Transparent Command Toolbar 
located on the Right Side of your Drawing screen. 

 The command line will ask for the Alignment, Pick the US98 Alignment.   

 The command line now asks for the Station, enter in the following without the plus symbol. 3342.57. 

 For Offset enter 66.02 and press enter. Keep in mind if the offset is on the Left side it is a negative 

number. 

 Press Enter twice to place the Block.  

 

 Since the Pull Boxes are all the same size and Pay Item numbers you can select the AutoCAD Copy 

command and using the center of the block as a base point select the Station Offset Transparent 

Command to place the remaining blocks with the location data as shown below. 

 Repeat steps to place Pull Boxes at the following offsets and stations: Keep in mind not to enter the 

stations with the + symbol. 

Offset  Station/Side Offset Station/Side Offset Station/Side Offset Station/Side 

42.53’ 30+74.08 RT -51.65’ 32+61.17 LT 66.06’ 33+65.61 RT 33.05’ 34+01.29 RT 

45.00’ 32+24.67 RT 62.00’ 33+42.57 RT -54.86’ 33+62.59 LT 65.89’ 34+34.12 RT 

65.30’ 32+30.58 RT 62.10’ 33+54.83 RT 34.42’ 33+74.98 RT -42.24’ 35+29.48 LT 



SIGNALS TOOLS - Pull Boxes ________________________________________________________________________ Chapter 7 

FDOT Traffic Plans Course - Signalization ©2017 FDOT 3-43 

-38.85’ 32+61.18 LT 65.83’ 33+54.83 RT -49.35’ 33+82.27 LT   

Exercise  4.8 Place Controller Assembly 

In this exercise the designer will use EMX to place a Base Mounted Controller.  

 Continuing in Dsgnsg01.dwg, zoom in near Pole 3 (South East) side of intersection. 

 Open EMX if it is closed. Make sure the correct Payitemdb file is loaded. 

 In EMX, navigate to Signalization > Controllers and Cabinets > Traffic Controller Assembly > 
Furnish & Install. 

 Select item 0670  5110 Traffic Controller Assembly, F&I, NEMA. 

 Select the Insert Block Icon located on the bottom of the EMX drawing Tools as in the previous 
exercise. 

 Type R in the command line and press enter to rotate the block like the Pull Boxes were rotated. Use 

the Lane Lines at the Stop Bar to Rotate to View. See the previous exercise for steps if necessary 

 Using the Station Offset Transparent Command Select CL98 as the Alignment. 

 Type in Station as 3360.25 and press enter. 

 Set the Offset to 64.68 and press enter until block is visible.  

 

Exercise  4.9 Draw Loop Lead in Wire 

In this exercise the designer will draw the Loop Lead-In wire from the end of the Loop Detectors to the Pull 

Box. The lead-In is paid for under the Loop Detector so the designer will draw this line using the AutoCAD 

PolyLine command, The figure below shows the Loop Lead-In drawn from Loop Detectors to the Pull Box. 

 

 Draw Loop Lead-In 

 Zoom in near the Loop Detectors placed earlier on the Southern Side of the Intersection 

 In Civil 3D, set the Current Layer to LoopLI.  
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 You can type in the layer name on the command line to set it current. 

 Type PL on the command line to start the Polyline command. 

 Snap to the end points as shown in images. 

 

 Repeat this process on the remaining two Loop Detectors. Connect to pull box. Drawing should 
resemble Image below. 

 

 

 Using the Poly Line command, draw a line from Loop L-7 parallel to the Stop Bar to a point past 

the last Loop L-4, then into the first Pull Box as shown in the next figure. The three images below 

represent the other connections 
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Note The location of the Pull Boxes will be dependent on each individual project. The placement of Loops, 
Types of Loops used and Loop Lead-In wire placement may vary from district to district, consult with 
the district traffic engineers regarding these issues. 

 Save your file. 

DESIGN SETTINGS 

The conduit Lines are special Linestyles that are delivered in the State Kit. It is specifically created to match 

the PPM examples. 

Exercise  4.10 Place Conduit 

In this exercise the designer will draw conduit from Pull Box to Pull Box and then to the Controller Cabinet. 

This exercise will use three different types of Conduit, Underground and Under Pavement and Open Trench. 

The next figure shows the types of conduit drawn in Plan view. 

 

 Place Conduit Underground 

 Continuing in Dsgnsg01.dwg, zoom in near the Pull Box at Station 30+74.08 placed in a previous 

exercise. 

 Open EMX, if closed. Make sure the correct Payitemdb file is loaded. 

 In EMX, navigate to Signalization > Conduit. 
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 Select item 0630 2 12 Conduit, Furnish & Install, Underground or Underpavement- Directional 

Bore. 

 Select the Polyline Command  from the EMX drawing tools. This will set the Civil 3D Layer 
symbology and draw with influence. 

 Using your Midpoint Osnap Snap to the midpoints of the Pull Boxes. See figure below. 

 

 Continue to place the rest of the Conduit item 0630 2 12 Conduit, Furnish & Install,  Underground 

or Underpavement- Directional Bore around the intersection and down the US98 Alignment. 

Complete the conduit from the Pull Box to the Controller Cabinet.  

 Zoom to the area near the Signal Poles and draw a line from the Signal Pole to the Pull Box. 

 

 Drawing should resemble image below. 
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PLACING TEXT LABELS 

There are several different types of notes and labels that are placed on Signal Plans that are not used in other 

components. For example the Pole location label and the Pay Item number box. These are handled with a 

combination of Civil 3D label styles and from the FDOT Traffic Palette.  

Exercise  4.11 Place Pole Location Label 

 

 To start lets label Pole No. 4. Switch to the Annotate Ribbon > Click the top half of the Add Labels 
button and select the following options 

 

 Select Add > Select the US98 Alignment and then the center of Pole 4. Drag the label off of the 
Pole to remove the box and show the Leader Line. Currently your drawing should look like image 

below. To drag label off select the label and hover over the grips, select the grip that says Move 

Label. 

     

 Select the Label and select Edit Label Text   from the Contextual Ribbon. 

 Click in the Text Preview box and add the number 4 to the Pole Number as shown below and select 

OK. The label should update and look like image to the right. 

   

 You could Place the label again for the other 3 Poles like the above steps but this time use the Copy 

command and select the center of the Pole as the base point and select the other the center points on 
the poles. Notice how the label updates with the Station, Offset, & Side, this is because the Labels 

are dynamic. 
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 The drawing should look like below. 

 

Similar to the Pole Location label is the Pay Item Number box, this block can be placed from the palette 

previously mentioned. Once this block is placed it turns into an AutoCAD table and can be edited by clicking 

in the individual cells and type the data in, there are also cells with a gray border (which will not print) around 

this table which represents where the lengths of the conduit gets filled in. 

 

This block is placed in the general location of the item it is referring to and a leader line if needed is drawn from 

the Pay Item box to the item. Next to the pay Item Number box the designer will add a piece of text with the 

quantity and unit as shown below.  

 

Exercise  4.12 Place Pay Item Number Box 

In this exercise the designer will place the Pay Item Number Box then add a leader line and arrow head as shown 

above. 

 Continuing in the Dsgnsg01.dwg, from the FDOT Traffic Palette select Signal Blocks tab > 

SignalPayItem > Insert underneath the Conduit as shown above. Using the same techniques you 

have learned earlier rotate the table as necessary.  

 To add text to the table select in the cell you want to type and it will become active. For Pay Item 

Number enter 0630 2 12. 

 Delete the entry’s you do not need by clicking in the cell and pressing delete. 

 Select the Conduit and Right Click > Properties to get the Length.  

 Enter the length 147 LF into the gray box to the right of the Pay Item Number.  
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 Copy the Pay Item Table and move it closer to the conduit connecting the pull boxes.  

 Get the distance of the conduit and enter it in the box to the right which is 18 LF. 

 Type in Leader on the command line and select a point on the conduit and the top right corner of 

the pay item box as shown above.  

 Next Copy a Pay Item Table and place it above the conduit in the Intersection as shown below 

 

 We have to add a top Row to the table with no border so as to enter in the Length of the conduit. 

Select the Table and on the Contextual Ribbon select  Insert Above. 

 Select the cell above the Pay Item Number. We need to turn the border gray so it won’t print. Select 

 Edit Borders. 

 Click in the following order. 

 

 Type in the Length (109 LF). 

 Using what you have learned copy and enter in the appropriate data. Your drawing should look like 
image below.  
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Note Drawing a Leader Line is optional when the labeling is obvious. However, when the label is placed a 
considerable distance from the item being labeled, a leader line is required, but the arrowhead is 
optional depending on the Districts internal preference. 

 

Note You can always select the cell you are not using on the Pay Item Number Table and select Delete 
Columns to remove, if your drawing gets too busy. Remember the gray borders will not show on a print. 
Note that the Top Right Corner in the image shows the Tables with the Deleted Columns.  

 

 

 

 

This concludes the workshop exercises. 



SIGNALS TOOLS - Placing Text Labels _________________________________________________________________ Chapter 7 

FDOT Traffic Plans Course - Signalization ©2017 FDOT 3-51 

 


